Creating Your Own Polyphony Model
1 Introduction

This paper is written for those who have bought a copy of Polyphony and wish to model their own application.
You start your own model by using one of our models as the base.

On the web site – www.weaverbird/polyphonyprod.htm – there are two models:
1. An example model for an Order Processing application.

2. An empty model. I will call this the New Model file.
Naturally, we expect you will want to use the New Model file as your starting point, but you may want to experiment on the Order Processing application.

Each model is a single file. If you want to start a new model, simply load down the empty model. You may want to make a copy of this file so you can start another new model without having to reload it from the web site.

To open the model, simply click on the model file. Alternatively start WeaverBird and use the open model command.

Before you can update this model, you need to have set the update key. To do this, you must first open one of these files. Then from the “Admin” menu, choose the “Allow Model Update” command. A dialogue will be displayed in which you can enter the key. You will need to buy the product to be given the key. This can be done from the web site noted above. Alternatively, you can put in “30 days” as the key and you will be given a 30 day trial.
Note the key is for the model, not the file. This means that if you have another file that uses the same model, you will have update facilities (unless the person who has given you the model has explicitly switched it off.) Thus the key works for both the Order Processing application and the New Model file.

To create your own model, you will want to do three tasks.

1. Populate the model data with your own information. See section 3 for details.

2. Change the report text. Most of the report text is generated, so altering the report text is largely a matter of editing the introductory text. See section 4 for details.
3. Distribute your model. You may want to set the report as first window the user opens, and you may want to give them a read only copy. How to do these tasks is discussed in the next section.
Also in the next section we outline some WeaverBird basics that are useful for you to being working on your model.
The final section is a reference section that describes the Polyphony schema in detail.

2 Some WeaverBird Basics

When you run WeaverBird you either get the Welcome screen or, if you are ran WeaverBird by clicking on a model file, you open the model. The only commands you will probably want to use in the Welcome screen are the “Open Existing Model” command and the “Exit the Application” command, which do what they say. When you open a model you either get a Report screen or the Model Control screen. The Report screen is for model readers – you will want to set up your model to have the report screen as its first screen for all your readers. The Model Control screen is for you – people who want to add model data and change reports.

When you open the model called New Model file, you will see a Model Control screen. The body of the Model Control screen has three columns.
· Left column – this is for reports. Click on one of the names here to start the report.

· Middle column  - model data. Click here to select some model data. You must select some model data to generate a diagram.

· Right column – diagrams. Click here to generate a diagram.

To set a report to run when the model starts up, as was done for the Order Processing example, run the report and, in the report window, use the “Run on Start Up” command in the “File” menu.
If the Model Control screen is not running, you can always run it by using the “New Model Control Screen” command in the “View” menu.

Using Diagram
You can run a diagram from the report – the report text will have a link for you to click – or from the Model Control screen. If you run a diagram from the Model Control screen, in many instances you will first be presented with a dialogue that will allow you to select the element which will be the focus of the diagram.

If the diagram does not fit in the screen you can scroll in the normal way. Alternatively, you can change the size of the diagram. Use the resize box on right hand side of the menu bar or use the “Fit to Screen” command in the “View” menu.

To display a key to the diagram use the “Show Diagram Key” command in the “View” menu.

Often shapes in the diagram will be active, meaning that if you click on them something will happen. The active shapes are usually text or icons like “+” and “-“.
If the shape is not active, it can often be moved around by using the mouse to drag it. This may make the diagram look better to the eye.
In the “Diagram” menu of the diagram are commands for displaying more or less information. All the commands of the form “... for selected” will draw a new diagram using the selected object as the starting point. You must therefore click on the shape you want more information about before using this diagram. In the “Browse” menu is a command called “View Data Object” which will show you the underlying data behind the shape on the diagram. Again in the “Diagram” menu, is a command called “Show Notes” which displays a description of the selected shape (if it has one.)  You can stop displaying notes by using the command “Clear all Notes”.

Sometimes you want to paste a diagram into another document. To do this, create an image file from the diagram by using the “Export as Graphic” command in the “File” menu. This creates an image of the diagram. I find that if I am importing the file into a Word document or into a model report, the “PNG” format works just fine.

In the report text supplied, there is information about each kind of diagram.
The Structure of the Data

The data is made up of objects. Objects represent things in the model (like Tasks, Screens and Data Entities). Objects have attributes which give the objects data like a name or a quantity.

The most common attributes are data attributes. These are strings (i.e. text – a string of characters), integers, floating point numbers, booleans, enumerations, dates and time. Booleans take a value of true or false. Enumerations take a value from a list of predefined values. You might for instance define an enumeration like days_or_the_week and the predefined list would be Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, and Sunday. 

One kind of attribute is called a reference attribute. A reference attribute points at another object (or indeed the same object). 
Collections are attributes that are lists of values. Most commonly, they are lists of object references. Collections can be lists or sets. The main difference is that you can change the order the elements appear in a list, and you can’t do that for a set.
Every model had a root object. The root object is always there. It is the starting point. To find data in the model you start at the root object and follow collections or object references to find the object you want.
The structure of an object – mainly its attributes – is described by an object definition which exists in the model’s schema. In the next section and the last section you will see documentation about the object definitions for the Polyphony model. You don’t have to define all the attributes for every object. You can instead inherit some of the attributes from another object definition. This is called inheritance.

You will find that sometimes, when you update an object, additional updates are done for you. These are caused by settings on the attributes. They are.
· Inverse – suppose object A has an attribute that points at object B. Object B might have an attribute that points back at object A. If these attributes are set up as inverses then when one attribute is assigned the other one (the inverse) is automatically assigned as well.

· Cascade delete – if an object is deleted, all objects referenced by an attribute with cascade delete set, will also be deleted.

· Cascade clone - if an object is cloned (that is, a copy is made of it), all objects referenced by an attribute with cascade clone set, will also be cloned, and the reference will be set up to point at the cloned object not the original.
Using the Browser

To add data to the model data, select the model data you wish to update and use the “Browse Model” command in the “Browse” menu. You can use the “Browse Schema” to see how the model is defined, but you should not have the privileges to update the schema.

A copy of a browser screen is shown below in figure 1.
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Figure 1. A Browser Window.
The darker boxes are objects, the lighter boxes are collections. Basically, you can click any coloured italics text and the browser will so something, as explained in the text. Also you can click on a “+” sign in a collection and the object will be displayed. Click on a “-“ sign and the object will no longer be displayed. The “Main” object in the top left hand corner is the root object of the model and the display builds rightwards or downwards.

The little red arrows in the collection allow you to delete or duplicate (i.e. clone) the object. If the collection is a list, click on the red arrow and you will have options to move the element up or down the list. If the little boxes next to the red arrow is clicked, it turns red. This indicates the object is selected. Selected objects can be used for building list of objects to assign references to, or for cutting and pasting between lists.

The numbers in curly brackets (like {105}) are surrogates. Every object has a unique surrogate number. It is useful when there are two objects with the same name or some objects with no name.

In general, the browser tries to disallow command that will cause problems later. For instance, the DataItemList on the bottom right of figure 2, only allows you to add new objects to the list. That is because we are preventing you sharing a dataitem between two data entities which could be confusing later.

 Backup
You can take a backup copy of the model file like any other file. You might want, however, to use the Export facility to create a text file of the model data. Exporting to a text file and importing again are a technique you may need to use when going to a later version of the model that has a different data structure. It is also sometimes useful when you want to make a big change – like copying in lots of data from another model.

The other way to create a copy of the file is to use the “Copy File” command in the “Admin” menu. This will allow you to create a copy with different security settings, like make it read only.

You will find more information about all the topics in this section in the “Using WeaverBird” command in the “Help” menu.

3 Populating the Model Data

You populate the model data by using the browser. Starting from the Model Control screen, select one of the model data names in the middle column. Then use the “Browse Model” command in the “Browse” menu.

Alternatively you can import a text file. The layout is like XML. To see what it looks like try exporting an existing set of model data, such as the Order Processing example. You will notice is that each element has a text like Surr = “403” in it. Surr is short for surrogate. Every element has a unique surrogate. References to objects are in the form “{403}” where the number is the surrogate of the object being referenced. When you add data to the text file, you don’t need to add a Surr = clause unless you want to create a reference to your newly added object.
The disadvantage of using the text form is having to remember the object definition names and the object attribute names, and managing new surrogate numbers. It is most useful for big changes like copying and pasting text from one model to another.

You can of course mix and match; use the browser, export a text file, update it, and import it again.

In the rest of this section, we describe the different kinds of objects found in the model data. These object definitions fall into several categories:
· Main and general – the root object.
· Stakeholders and requirements – useful in design to document what the stakeholders are telling you.
· Tasks – modelling the tasks.
· Processes – modelling the business processes.
· Operations – modelling the details of the application’s functionality.

· Information – modelling the data used by the tasks.
· Security and Portals – modelling the user interface and security.
· Scripts – these show how the tasks can be used, showing how operations change the data.
· Application Architecture – the application and data sources.
· Glossary – words and their definitions.
There is a subsection below on each of these.

The details of the object definitions are found in the reference section at the end of this document.

3.1    Main and General Purpose Object Definitions
There are only two object definitions in this part.

· Main is the root object of the model data. It is the object you see when you open the browser.
· NamedObj is inherited by all objects that need a name. It also supplies an attribute called Description for putting your description of the thing the object is modelling.

3.2 Stakeholders and Requirements

This is for documenting high level requirements. No diagrams or report generation uses this data. The object definitions are.

· Stakeholder. Stakeholders have requirements.

· Requirement define what the stakeholder wants. Requirements can have metrics.

· RequirementType provide a hierarchical way of classifying requirements. You can do this any way you want. 

· Metric defines a value and a unit.

3.3 Tasks

This section describes the objects associated with tasks. Tasks are units of business activities. Normally they are done by one person at one time, but they can involve several interactions with the IT application. The object definitions are.
· Task. Tasks have an attribute called ConsistsOf which is a set of TaskParts. The taskparts really define what the task does.
· TaskPart. The components of a task. TaskPart are further defined into:

· Screen define a user window layout.

· NonScreen define a task activity that is either for a non-screen device (like a bar code reader), or is not for an end user at all (like a B2B – business-to-business – message over the internet from a supplier.)
· External defines an external activity done as part of the task. For instance, a delivery task might have an external activity that is driving the truck.

· ScreenAction define how the screen responds to events, like hitting a button.

· TaskData defines data that is shared by all taskparts and is deleted when the task ends. An example would be a “shopping cart” in a web ordering application.

· DataSecurity defines additional security constraints on the data that apply to a task.

· OpGroup defines a list of operations that can be called by other operations. OpGroups are defined within a task and it’s a way of defining shared behaviour.

· InnerService defines a parameterized list of operations that can be called by other operations. They are defined outside a task and thus define behaviour that is shared across tasks. It is called an “Inner” service because it is an IT service for IT applications and not a business service for an end user. InnerServices can be

· RequestResponseService. A call that gives a response. 
· AsyncService. A call that does not give a response. Sometimes called a “fire and forget” service.

· InParameters. Input data for an InnerService.

· OutParameters. Output data for a RequestResponseService.

· ReportTask is like a Task but is only used for enquiries. It is defined more simply than a Task since the emphasis is on what data it retrieves not how the data is displayed and formatted.
3.4 Processes
Processes model business processes. In Polyphony processes can model any related combination of tasks; it is about capturing the notion of tasks causing other tasks to happen. The object definitions are.

· Process is where business processes is defined. The steps in the process are described by ProcessStep objects. Most ProcessStep objects are expected to point at tasks but they can also contain embedded ProcessStep objects. This is there to capture the concepts like parallel tasks.
· ProcessStep. A process step defines its own next step, thus creating a string of steps. A process step can be.

· TaskStep. Points at a Task.

· GroupStep. A set of process steps. Additional attributes indicate whether only one of the process steps is run or all are in parallel. Also attributes indicate whether the process steps are run more than once. 
3.5 Operations
Operations define the functionality. A judicious blend of plain English text and structured information is used. Essentially the idea is to define the data movements fully, but leave everything else (for instance, the test conditions and the calculations) to plain text.

· Operation. All of the operations listed below have a list of DataMapping objects that defines detailed data movement. The operations can be any one of the following.
· MoveData – for simply moving data.

· MoveTableData – for moving from table to table (see the section below on Information).

· TableOp. Operations that work on tables. These are.

· AddToTable – adds a new row to a table.

· RemoveFromTable – removes a row from a table.

· ClearTable – removes all the data from a table.

· DataEntityOp. Operations that work on data entities (see the section below on Information for more on Data Entities). These are.

· SelectDataEntity – selects a data entity from a database. The selection criteria is specified in the operator description.

· FillTableFromDataEntities – fill a table (e.g. on a screen) from data entities. There would often be some kind of filter.
· CreateDataEntity – creates a new data entity.

· UpdateDataEntity – updates a data entity (the entity should be previously selected or created.)

· DeleteDataEntity – deletes a data entity.

· TrayOp. Operations that work on work pending trays (see the section below on Information for more on work pending trays). These are.

· PutInTray – puts the data entity in a tray.

· RemoveFromTray – removes a data entity from a tray.

· FillTableFromTray – fills a table by reading all the data entities from a tray.

· Call – calls an inner service.

· OtherOutput – generates a non-screen output, like a print output.

· LoopOp. Has a list of operations that are repeated many times.

· LoopOverTable. Iterates over a table. Each row is selected in turn from the table.

·  LoopOverTray. Iterates over a tray. Each item is selected in turn from the tray.

· If. Allows branching of operations.

· Verify – checks the data for correctness.

· OpGroupCall – calls an OpGroup.

· ResetScreenToInitialValues – blanks out all the data items on the screen.

· ResetTaskDataToInitialValues – blanks out the TaskData in the Task.

· Stop – stops the processing of the list of operations.

· AbortData – undoes the data updates done by a task or series of tasks.

· MapDataItem – defines a data movement. The MapDataItem can be one of.

· InputDataItem – indicates that the input data item is used by the operation.

· MoveDataItem – moves a value from one data item to another. Below is an extended form.
· AccessDataEntity – the input data item is qualified by a key which is used to look up a Data Entity before the move takes place.

· OutOnlyMap – puts a value into a data item. This can be one of.

· SetValue – puts a constant or calculated value in the output data item.

· SetForeignKey – sets the output data item to a key of a Data Entity.

3.6 Information

This is for modelling the data in the database and elsewhere – for instance, on the screens and in the parameters. DataItemValue and DataItemForeignKey are the units of data. These can be combined into DataItemGroup and DataItemTable. DataItems are placed into DataHolders. Screens, parameters and data entities are all DataHolders. Data Entities are like tables in a database. The object definitions are.
· DataHolder – holds data items.
· DataEntity – a DataHolder in a database.

· DataItem – an attribute of a DataHolder.

· DataItemValue – a data displayable value like a number or string.

· DataItemForeignKey – a data value that is a key to data entity.

· DataItemGroup  - a collection of data items.

· DataItemTable – a table of data.

· WorkPendingTray – a list of data entities used to pass work from one task to another.

The concept of a work pending tray is there to provide a mechanism for passing information from task to task without specifying the implementation. The idea is that one task puts a data entity into a work pending tray and another task takes it out. A data entity can be put into any number of work pending trays.
3.7 Security and Portals

Portals are a way of grouping tasks into user interfaces. A portal may have security protection, that is, the user would be required to log on when they want to use the portal and log off when they have finished.

We don’t keep track of individual users. We keep track of the roles. A users needs a role when they access they system. Individual people usually have multiple roles – employee, clerk, line manager, product manager, for instance. Most tasks are associated with one role only, but we allow for more than one in the model.

A security context authenticates the users and keeps a record of the user’s roles. It’s possible a system (actually very likely) that there are multiple security contexts in an organization’s IT system. The user notices this because they are obliged to log on separately to different systems. We model this giving each a security context objects. There are single sign on systems and, if these are effective – from an end user and business perspective – then by all means model them as a single security context.

· SecurityContext – manages security authentication and roles.

· Role – a user role.

· Portal – a user interface.

· PortalTask – a task, report task, or portal that can be incorporated into a portal.

3.8 Scripts
Scripts are a feature used in the task diagram to show the task working.

Scripts are a list of commands. Each command processes something like a screen action. When it does so it executes the operations. There is not enough information in the operations to know how to operate, so the script commands are supplement by a list of ExtraCommands.
· Script – has a list of commands.
· Command – the element that is processed in a script.
· CmdScreenAction – a command that calls a screen action.
· CmdScreenUpdate – a command that set a data item on the display.
· CmdDoTaskPart – starts processing another task part.
· CmdGotoTask – a command for going to another task.
· ExtraCommand – extra data that supplements the command.
· IfExtra – says whether the true or false branch is taken.
· VerifyExtra – says whether the verify condition passes or fails.
· FillExtra – data for loading a table.
· SelectRowExtra – specifies the current row in a table, used by data item mapping.
3.9 Application Architecture

Polyphony is not meant to model the application architectures. These objects are only there to put placeholders for later application design.

· Application – the IT application.

· DataSource – a place to store data entities. Normally a database.

3.10 Glossary

The glossary supplements the text with definitions. Each word can have multiple definitions and each definition can have multiple words (synonyms.) There is also a breakdown by subject area.

Words can be related to each other (e.g. “is a”, “part of”, “opposite”). The types of relationship is not predefined. You set them up yourself using RelationshipKind objects.

The glossary object and a few relationship kind objects have been created and put in the otherwise empty model provided.

· Glossary – the container for glossary information (to stop it clogging up the Main object).

· WordOrPhrase – a word, acronym or phrase.

· Definition – some text defining the word or words. 
· SubjectArea – a grouping of words and sub-subjectareas that are related by their subject matter.

· WordRelationshipKind – the kind of work relationship.

· Reference – a word relationship.

4 Changing the Report

You can change the text in any section by using the command “Open Text Edit Window” found in the “View” menu.
Alternatively you can open the browser on the full report. This is done from the report window by using the “Browse Mini App” command found in the “Browse” menu.

An example of a browse screen is shown below in figure 2. The image shows that an attribute called Report expanded. This is a list of the sections. One of the sections – ApplicationOverview has also been expanded. The text for this section is in the attribute called “Text”, and if you click here you will see a text window (like using the Open Text Edit Window command mentioned above.) If you click on the attribute called “Sections” you will see the sub-sections to the section.
Generally speaking we expect that any text in square brackets (like “[do something here]”) indicates to the reader that we are expecting you to provide some text in this section. You don’t have to of course and you might want to add, remove or reorder the sections. To do this, use the browser in the normal way, editing the list of sections.
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Figure 2. Browsing the report.

Note too in the browser, that the service menu command has some commands that will help you, These are “New Diagram” and “New Image”. These add an object to the “Images” and “Diagrams” attributes respectively. To learn more, look at the “Developing WeaverBird Models” document on the web site (see the More Information section for more details.) 
The text you will see has tags in it. These are similar to HTML tags. The important tags are as follows.

<p>text</p>. This puts the text into a paragraph.

<i>text</i>. This puts the text in italics.

<b>text</b>. This puts the text in bold characters.

<ul><li>Line one.</li><li>Line two.</li></ul>. This creates a list, like this.
· Line one.

· Line two.

Replace the <ul></ul> by <ol></ol> and you have a numbered list.
Note tags can be embedded. Thus “<p><b><i>text</i></b></p>” puts the text in bold italics in a paragraph of its own.

The <img id = “image_id”> finds an image with an Id of “image_id” in the Images list and displays it. The easiest way to create a copy of an existing diagram is to turn the diagram into an image (using the “Export as Graphic” command in the “File” menu) and then use the “Insert” command in the text editor to insert and image – having first positioned the cursor in the right place to place the image.
The <diag id = “diagram_id”> works similarly. It finds a diagram with an Id of “diagram_id” in the Diagram list and displays it.

To reference another section use <ref section_id>some text</ref>. The “some text”will be underlined and if the user clicks it they go directly to the section defined by section_id. The section_id must match the “Id” attribute of a _ReportSection object (see figure 2).

For calling a diagram you use the <cmd nameofcommand>some text</cmd>. The nameofcommand is the name of an object in the “Commands” attribute – see figure 2 above.
For more information on all of this, see the “Developing WeaverBird Models” document.

There are other elements in a report you may change that are found in the root object of the report – the object called _MiniApp in figure 2. These are:

· Name – this is used for the title of the report.

· BaseLineOne – this is used for a line displayed at the bottom of the report window. I usually use it to name the author and the version of the report.

· BaseLineTwo – this is also used for a line displayed  at the bottom of the report window. I usually use it for copyright information.

· ModelName – this is used to identify the model data. The name must match one of the models listed in the middle column of the Model Control screen. Note, you can change the model name by using the “Rename Model” command in the Model Control screen.

5 More Information

There is more detailed documentation about using WeaverBird on the web (www.weaverbird.org.)
The documentation about how to use the browser and the main screens like the Model Control screen is found in the “Using WeaverBird” documentation that comes with the release. This is found by using the “Help” menu. The help also describes all the WeaverBird menu commands.

On the web, is a document called “Developing WeaverBird Models” which documents in full all aspects of developing a model. The Polyphony model has been developed for you, but this document is useful if you want to understand how it works in more detail. It is also useful if you want to put diagrams in your document or write new report commands.
Also on the web site are several papers that discuss how to use Polyphony creatively to improve your business.
6 Reference – the Model Data Schema
You will see when you use the browser that the model data is made up of objects. The main part of this section is a list of the objects and their attributes.

A few points about these descriptions need to be made.

· The text “Subtype of <something>” means that the attributes in <something> are included in this object.
· Each attribute is described by a name, a type and, usually, a comment.

· (Cascade = Child) means that the when the object is deleted or cloned, the objects in the collection are deleted or cloned.
· (Inverse = <something>) means that when this reference is set up, the inverse relationship is set up.

· Some object definitions are defined as virtual object definitions. This means that an object of this definition never exists in the model data. The definition is only used to define other object definitions using subtypes.
The object definitions are in alphabetic order.

6.1 AbortData, Subtype of Operation

This operation undoes data updates associated with a task or group step. There is no impact on the screen flow. The additional attributes are:

· AbortKind. An enumeration. Controls the degree to which data updates are undone. It takes a value from:

· UndoTaskOnly – undoes updates originally done in this task.

· UndoGroupStep – undoes the updates originally done in the whole of the group step.

· UndoProcess – undoes the updates originally done in the whole process.

· GroupStep. A reference to a GroupStep object. Must be a GroupStep that encloses this task. Only relevant if AbortKind is UndoGroupStep.

6.2 AccessDataEntity, Subtype of MoveDataItem

Note this is a subtype of MoveDataItem, and therefore has In and Out attribute. The difference is that the In attribute is supplemented by a lookup on a data entity. The additional attribute is:

· Key. A reference to a DataItem object. Used to find the data entity that contains the In data item.

6.3 AddToTable, Subtype of TableOp

Adds a row to the target table. There are no additional attributes.

6.4 Application, Subtype of NamedObj

To model an IT application. There is one additional attribute.
· DataSources. A set of DataSource objects.

6.5 AsyncService, Subtype of InnerService

A service that does not send a response to a caller. There are no additional attributes.  

6.6 Call, Subtype of Operation

Calls an inner service. Whether the call is asynchronous (i.e. fire and forget) is defined by the type of the service (i.e. Async or Request response service). There is one additional attribute.

· Service. A reference to an InnerService object. The service being called.

6.7 ClearTable, Subtype of TableOp

Removes all rows from the target table. There are no additional attributes.

6.8 CmdDoTaskPart, Subtype of Command

This starts another screen (used when the choice of screen or external activity is a user choice and not driven by a screen action.)

· TaskPart. A reference to a TaskPart object. The task part (screen, non screen or external activity) to process.

· ExtraCommands. A list of ExtraCommand objects (Cascade = Child). These supplement the processing of the task part operations.

6.9 CmdGotoTask, Subtype of Command

This starts another task. The attributes are:

· Task. A reference to a Task object. The task to start.

6.10 CmdScreenAction, Subtype of Command

This is a command for processing a Screen Action. The attributes are:

· ScreenAction. A reference to a ScreenAction object. The screen action to process.

· SelectRow. An integer. If the screen action is initiated by a selection of a row from a table or list, this attribute tells the script what row to use.

· ExtraCommands. A list of ExtraCommand objects (Cascade = Child). These supplement the processing of the screen action operations.

6.11 CmdScreenUpdate, Subtype of Command

This command is to simulate the user putting data in the screen. The attributes are:

· DataItem. A reference to a DataItem object. The screen data item being updated.

· Value. A string. The value.

· TargetRow. An integer. This is used if the data item is a table. It selects the row to update.

6.12 Command

This is a virtual object definition. It has no attributes.

6.13 CreateDataEntity, Subtype of DataEntityOp

Creates a new data entity instance. There are no additional attributes.

6.14 DataEntity, Subtype of NamedObj, DataHolder

A data entity. A data entity is like a table in a relational database. The additional attributes are:

· DataSources. A set of DataSource objects. The DataSource hold the data entities.

· Ops. A set of DataEntityOp objects (Inverse = DataEntity). The operations that use the data entity.

· Trays. A set of WorkPendingTray objects (Inverse = DataEntity). The work pending trays associated with the data entity.

· DataSecurityList. A list of DataSecurity objects (Inverse = DataEntity). The data security objects that restrict access to this data entity.

· PluralName. A string. A plural form of the data entity name. If this is left null, then a plural is formed by adding an “s” on the end of the name.

6.15 DataEntityOp, Subtype of Operation

This is a virtual object definition. It is for operations that use data entities. The additional attributes are:

· DataEntity. A reference to a DataEntity object. The target data entity for the operation.

· InstanceId. A string. Sometimes you want to two or more instances of a data entity at one time. You can use this string to distinguish between them. For instance, if you are copying data from one data entity to another you might have one InstanceId as “Source” and the other as “Destination”.

Note, that data mappings use InInstanceId and OutInstanceId to disambiguate the Data Entities.

6.16 DataHolder

DataHolder is a virtual object definition included in any object definition that needs to hold data. The attributes are:
· DataItems. A list of DataItem objects (Inverse = Holder, Cascade = Child). The data items.

· KeepInSyncWith. A reference to a DataHolder object. This is to prompt the user that the attributes should be kept in sync.

6.17 DataItem, Subtype of NamedObj

This is a virtual object definition. Specifies an attribute. The additional attributes are:

· InputBy. A set of InputDataItem objects (Inverse = In). This and the next three attributes are inverses of the data mapping objects.

· MoveSource. A set of MoveDataItem objects (Inverse = In).

· MoveDest. A set of MoveDataItem objects (Inverse = Out).

· SetBy. A set of OutOnlyMap objects (Inverse = Out).

· Holder. A reference to a DataHolder object (Inverse = DataItems). The owner.

6.18 DataItemForeignKey, Subtype of DataItem

A data item that represents a key for a data entity. There is one additional attribute.

· DataEntity. A reference to a DataEntity object. The foreign key is of this data entity.

6.19 DataItemGroup, Subtype of DataItem, DataHolder

A group has attributes – for instance a data item representing an address might have attributes like street and town. There is one additional attribute.

6.20 DataItemTable, Subtype of DataItem, DataHolder

A table is a list of rows. The rows have attributes defined by the DataItems attribute.

6.21 DataItemValue, Subtype of DataItem

A data item that is a printable value. The additional attributes are:

· Type. An enumeration. The kind of value. It takes a value from:

· Identifier – the key value of a data entity.

· Number – a number of any sort (integer, floating, etc).

· Money – a money value.

· Text – a string of characters.

· Enumeration – one of a set of possible values.

· DateTime – a date and time.

· PossibleValues. A string. Required for an enumeration type value and can be used to specify a range of values for the data item.

6.22 DataSecurity

These objects are used to restrict the tasks to certain data entities. For instance, if a task supports a customer looking at their account, a DataSecurity object would tell you that they can only access their own accounts and not anybody else’s. The attributes are:

· Task. A reference to a Task object (Inverse = DataSecurityList). The task that uses the DataSecurity object.

· DataEntity. A reference to a DataEntity object (Inverse = DataSecurityList). The data entity being restricted.

· Constraint. A string. Describes the security constraint in plain English.

· Role. A reference to a Role object. Indicates the role that this restriction applies to. If this attribute is null, we use that to indicate that all users of the task are restricted by this object.
6.23 DataSource, Subtype of NamedObj

To model a database or other form of storage for data entities. The additional attributes are:
· Apps. A set of Application objects (Inverse = DataSources).

6.24 Definition

The definition describes the words.

· SubjectArea. A set of SubjectArea objects.

· Words. A set of WordOrPhrase objects (Inverse = Definitions).

· Definition. A longstring. The actual descriptive text.

· References. A set of Reference objects (Inverse = A, Cascade = Child). Relationship to another definition.

· ReferencedFrom. A set of Reference objects (Inverse = B). The reverse relationship.

6.25 DeleteDataEntity, Subtype of DataEntityOp

Deletes a data entity. There are no additional attributes.

6.26 ExtraCommand

A virtual object definition. Used in script commands to supplement the operations.

6.27 External, Subtype of TaskPart

This component of a task is for modelling non-IT activities. For instance a delivery consists of login on at the start of the journey, making the journey and login off at the end of the journey. Only the first and last are IT tasks. The additional attributes are:

· ReportDone. A reference to a TaskPart object. The next TaskPart that is processed if the external activity is done successfully. 

· ReportFailed. A reference to a TaskPart object. The next TaskPart that is processed if the external activity fails.

6.28 FillExtra, Subtype of ExtraCommand

This tells a “fill table” operation how to fill up with data. The attributes are:

· Cols. An integer. The number of columns.

· Rows. An integer. The number of rows. If the values list is not big enough for all rows, the rows are filled with blank data.

· Values. A list of strings. Interpreted as a table of rows using the Cols attribute to tell the system how many values are in each row.

6.29 FillTableFromDataEntities , Subtype of DataEntityOp

Fills a table from a data entity. For each instance of the data entity there is a row in the table, or less if some comment defines a selection criteria. The additional attribute is:

· Table. A reference to a DataItemTable object. The destination table.

6.30 FillTableFromTray, Subtype of TrayOp

Fills a table using all the entries in a work pending tray. There is one additional attribute: 

· Table. A reference to a DataItemTable object.

6.31 Glossary

The placeholder for the glossay. The attributes are:

· A ... Z. A list of WordOrPhrase objects (Cascade = Child). An attribute for each letter.

· Definitions. A set of Definition objects (Cascade = Child). Somewhere to store the definitions.

· RelationshipKinds. A set of WordRelationshipKind objects (Cascade = Child).  Somewhere to store relationship kind objects.

6.32 GroupStep, Subtype of ProcessStep

When you want the next step to be several tasks then you need to set NextStep to a GroupStep object. Note that both the embedded ProcessStep objects and the GroupStep object itself will have NextStep attributes. The NextStep attribute for embedded objects are the start of what could be a mini process it its own right. The NextStep attribute for the GroupStep object should be the next step when everything (i.e. all the little mini processes) have finished. The additional attributes are:

· Steps. A set of ProcessStep objects. Depending on the other settings the process steps that are started in parallel when the GroupStep object is started.

· ParallelProcessing. An enumeration. Denotes how many of the Steps start at once. It takes a value from:

· ProcessAll. Process the steps in parallel (including all the step’s NextSteps).

· ProcessOne. The Steps represent two or more alternate paths.

· ProcessSome. May be more than one path processed but less than all of them.

· ParallelComment. A string. The conditions that control alternate paths.

· Many. A boolean. If true, the ProcessSteps in Steps are processed multiple times.

6.33 If, Subtype of Operation

Implements conditional branching. The additional attributes are:

· Condition. A string. The expression, in English, that controls with branch to take.

· TrueOps. A list of Operation objects (Cascade = Child). The operations process if the condition is true.

· FalseOps. A list of Operation objects (Cascade = Child). The operations to process if the condition is false. 

6.34 IfExtra, Subtype of ExtraCommand

This tells an “if” operation what branch to take. The attributes are:

· TakeTrueBranch. A boolean. If true, process the true ops, else process the false ops.

6.35 InnerService , Subtype of NamedObj

A virtual object definition. An inner service is used to model a shared service. Note, the Task OpGroup attribute holds shareable lists of operations within a task, a inner service is about sharing functionality across Tasks. For instance, if you have many different tasks to take money from a bank account (e.g. using a clerk in a bank, an ATM machine, using a credit card) you may want to model the actual withdrawal logic in one place. The additional attributes are:

· InData. A reference to an InParameters object (Cascade = Child). The input parameter data.

· Processing. A list of Operation objects (Cascade = Child). The functionality.

· Application. A reference to Application objects. To document what inner service uses which application.

6.36 InParameters, Subtype of DataHolder

The input parameters for services. The main attribute is DataItems in DataHolder that specifies the input parameter data. The additional attribute is:

· Service. A reference to InnerService object (Inverse = InData). Points back to the service object.

6.37 InputDataItem, Subtype of MapDataItem

Used to indicate that the data item is loaded into the operation. For instance, when doing a search, the search criteria need to be loaded into the search processing. The additional attribute is:

· In. A reference to a DataItem object. Where the data comes from.

· InInstanceId. A string. For choosing between different data entities of the same type.

6.38 LoopOverTable, Subtype of Operation

A loop driven by iterating over a table. The additional attributes are:

· Ops. A list of Operation objects (Cascade = Child). The operations called each loop iteration.

· Table. A reference to a DataItemTable object. The table being iterated over.

6.39 LoopOverTray, Subtype of LoopOp

A loop driven by iterating over a tray. The additional attributes are:

· Ops. A list of Operation objects (Cascade = Child). The operations called each loop iteration.

· Tray. A reference to a WorkPendingTray object. The tray being iterated over.

6.40 Main

This is the root object of the model data. Everything you can see in the browser must be directly or indirectly connected to main. The attributes are:
· Title. A string. This is used as the heading in the Model Control screen.

· Summary. A longstring. This is for documentation purposes. It is not used anywhere.
· Stakeholders. A set of Stakeholder objects (Cascade = Child).
· Requirements. A set of Requirement objects (Cascade = Child).
· Tasks. A set of Task objects (Cascade = Child).
· ReportTasks. A set of ReportTask objects (Cascade = Child).
· DataEntities. A list of DataEntityObjects (Cascade = Child).
· WorkPendingTrays. A set of WorkPendingTray objects (Cascade = Child).
· Processes. A set of Process objects (Cascade = Child).
· Portals. A set of Portal objects (Cascade = Child).
SecurityContexts. A set of SecurityContext objects (Cascade = Child).
· InnerServices. A set of InnerService objects (Cascade = Child).
· Applications. A set of Application objects (Cascade = Child).
· DataSources. A set of DataSource objects (Cascade = Child).
· SubjectAreas. A list of SubjectArea objects (Cascade = Child).
· Glossary. A reference to a Glossary object (Cascade = Child). The object has been created already.
Where there is no description of these attributes, see the description on the object type.

6.41 MapDataItem

A virtual object definition. The addition attribute is:

· Op. A reference to an Operation object (Inverse = DataMapping). Points back at the operation.

6.42 Metric, Subtype of NamedObj

This defined a numerical value and a unit of the value. The additional attributes are:

· Value. A floating point number. The value of the metric.

· Unit. A string. The unit of the value.

6.43 MoveData, Subtype of Operation

An operation for moving data. The details are in the DataMapping attribute. There are no additional attributes.

6.44 MoveDataItem, Subtype of MapDataItem

The operation moves data from one data source to another, for instance from a data entity to a screen display. The additional attributes are:

· In. A reference to a DataItem object. The move source.

· InInstanceId. A string. For choosing between different data entities of the same type.

· Out. A reference to a DataItem object. The move destination.

· OutInstanceId. A string. For choosing between different data entities of the same type.

6.45 MoveTableData, Subtype of Operation

Like MoveData except it is for moving tables. The reason why this operation exists as well as MoveData is that the data mappings specify how data is converted from the In table to the Out table.

· In. A reference to a DataItemTable object. The source table.

· Out. A reference to a DataItemTable object. The destination table.

6.46 NamedObj
This is a virtual object definition. Most objects belong to NamedObj. It gives the object three attributes:

· Issues. A list of Issue objects. Issues objects are defined by the system. See the Using WeaverBird documentation for more detail (use the “Using WeaverBird” command in the “Help” menu.)
· Name.  A string. The name of the object.
· Description. A longstring. Comment about the object. The description is often incorporated the reports.
6.47 NonScreen, Subtype of TaskPart, DataHolder

This component of a task is for modelling IT supported tasks that don’t use a screen. An example might be using a bar code reader. The data items in the DataHolder supertype define the input data to the activity. The additional attributes are:

· InputSource. An enumeration. Used to tell you what kind activity it is. Takes a value from:

· BatchFile – a file used as input for a batch run.

· B2B – a business to business message over the internet or other network.

· SpecialDevice – some special device like a bar code reader.

· None – no input.

· RequiresSignOn. A boolean. The user must sign on. (Obviously, this is not relevant to batch file input.) 

· Processing. A list of Operation objects (Cascade = Child). The operations that tell you what the activity does.

6.48 Operation, Subtype of NamedObj

A virtual object definition. The additional attribute is:

· DataMapping. A list of MapDataItem objects (Cascade = Child). The details of the data movement.

6.49 OpGroup, Subtype of NamedObj

These objects are a means of grouping some operations that can be called from another operations. In other words it is about capturing and reusing common operations. The additional attributes are:

· Ops. A list of Operation objects (Cascade = Child).

6.50 OpGroupCall, Subtype of Operation

Calls one of the OpGroups in the Task object. OpGroups are simply a mechanism to avoid repeating a list of operations in different contexts.

· OpGroup. A reference to an OpGroup object. (OpGroups are nothing more than a list of operations.)

6.51 OtherOutput, Subtype of Operation

Send an output. The additional attributes are:

· Kind. An enumeration. The kind of output. It takes a value from:

· Email 

· HandHeldDevice

· Print

· WebMessage

· Other

· OutputTitle. A string. To give the output a name.

· ToUser. A reference to a Role object. The user that receives the output.

· InitiatedTask. A reference to a Task object. You expect the receiver of the output to start this task in response to the output.

6.52 OutParameters, Subtype of DataHolder

The output parameters for request response services. The additional attribute is:

· Service. A reference to RequestResponseService (Inverse = OutData). Points back to the service object.

6.53 Portal, Subtype of PortalTask

A user interface that incorporates tasks and sub-portals with authentication mechanism. The additional attributes are:

· Kind. An enumeration. It takes a value from:

· Screen – a normal screen interface.

· Nonscreen – a special device interface.

· SecurityContext. A reference to a SecurityContext object (Inverse = Portals). The security context that authenticates users for this portal.

· RequiresSignOn. A boolean. If true, then, when the portal is first used, the user must authenticate themselves with the security context. If false, they might still be required to authenticate themselves when they are doing something security critical.

· Tasks. A list of PortalTask objects. The components of the portal.

6.54 PortalTask, Subtype of NamedObj

These are the things that run in portals and include Tasks, Report Tasks and Portals themselves. The additional attributes are:

· UsedByPortals. A set of Portal objects (Inverse = Tasks). The owning portals.

· Roles. A set of Role objects. These should be a subset of the roles in the UsedByPortals portals. It is a further restriction on the roles allowed to do this task (or portal).

6.55 Process, Subtype of NamedObj

The root object for processes. The additional attributes are:

· FirstStep. A reference to ProcessStep. The first step in the process.

· StepsStore. A set of ProcessStep objects (Cascade = Child). This is just a convenient place to store the ProcessStep objects.

· ErrorTasks. A list of Task objects. These tasks undo work done by the process, if there is an error or a cancel request.

· Monitors. A set of ReportTask objects (Inverse = Monitors). The report tasks that keep tabs on how the process is going.

6.56 ProcessStep

This is a virtual object. The attributes are:

· NextStep. A reference to ProcessStep object. The next step in the process. If this is null the process or the leg of the process is finished.

· PreviousSteps. A set of ProcessStep objects (Inverse = NextStep). The previous step(s) in the process. If there are more than one, then all the previous steps must be complete before this step is processed.

· Process. A reference to Process object (Inverse = StepsStore). A pointer to the owning process.

6.57 PutInTray, Subtype of TrayOp

Puts the current data entity in the tray. There are no additional attributes.

6.58 Reference

The relationship between definitions. The attributes are:

· From. A reference to a Definition object.

· To. A reference to a Definition object.

· Kind. A reference to a WordRelationshipKind object. What the relationship is called going in both directions.

6.59 RemoveFromTable, Subtype of TableOp

Removes a row from the target table. There are no additional attributes.

6.60 RemoveFromTray, Subtype of TrayOp

Removes a data entity from the tray. Makes the data entity current. There are no additional attributes.

6.61 ReportTask, Subtype of PortalTask, DataHolder

A report task is like a task but it is only used for reporting on data rather than moving a process forward. We don’t model report tasks to the level of the detail as a task by defining all their screens. Instead we just define what data is displayed. The additional attributes are:

· Kind. An enumeration. The nature of the access. It takes a value from:

· EnquiryScreen – the data is sent when the user requests it.

· PushReport – the enquiry data is sent to the user (by paper, by email, by text message, etc) at fixed times of day, or in response to another event.

· InputOps. A list of Operation objects (Cascade = Child). Operations need to fill the data display.

· RequiresSignOn. A boolean. The report task must run in a security context.

· DataSecurityList. A list of DataSecurity objects. Specifies security restrictions on the data retrieved.

· Monitors. A set of Process objects. This indicates that the report task is designed to monitor one or more specific processes.

6.62 RequestResponseService  , Subtype of InnerService

A service that sends a response to the caller. The additional attributes are:

· OutData.  A reference to an OutParameters object (Cascade = Child)

6.63 Requirement, Supertype of NamedObj

These objects are meant to document stakeholder requirements. The objects are not used in any diagrams. The additional attributes are:

· Stakeholders. A set of Stakeholder objects (Inverse = Requirements). The stakeholder who owns the requirement.

· Type. A reference to a RequirementType object (Inverse = Requirements). See next subsection.

· AcrossAllTasks. A boolean. This means it is a general requirement across the system.

· RelatedTasks. A set of Task objects. The requirement is relevant to these tasks.

· Metrics. A set of Metric objects. Metrics that apply to the requirements.

6.64 RequirementType, Subtype of NamedObj

This defines the kind of requirement. In other words, instead of predefining the kinds of requirements, I let you make your own classification. The additional attributes are:

· Requirements. A set of Requirement objects (Inverse = Type).

· SubTypes. A set of RequirementType objects. Use this to form a hierarchy of RequirementTypes.

· Within. A reference to a RequirementType object (Inverse = SubType). Points up the hierarchy.

6.65 ResetScreenToInitialValues, Subtype of Operation

All the screen data is set to blanks and InputOps is processed again.

6.66 ResetTaskDataToInitialValues, Subtype of Operation

The task data is set to null values.

6.67 Role, Subtype of NamedObj

The user roles. The additional attributes are:

· Tasks. A set of Task objects (Inverse = Roles). Tasks that a user with this role can do.

· ReportTasks. A set of ReportTask objects (Inverse = Roles). Report tasks that a user with this role can do.

6.68 Screen, Subtype of TaskPart, DataHolder

This component of a task is for modelling screens. A task normally consists of many screens. Even something simple like updating a record consists of one screen to find the record and another to update it. The data items in the DataHolder supertype define the data displayed on the screen. That a data item is used for input only is figured out from the operations. The additional attributes are:

· InputOps. A list of Operation objects (Cascade = Child). The operations are used to build the display.

· ScreenActions. A list of ScreenAction objects (Cascade = Child). The screen actions are initiated by clicking on buttons, clicking on text, selecting from a list, or any other way.

· Initiator. An enumeration. Used to tell you how the screen starts. Takes a value from:

· UserRequest – the user starts the screen.

· Push – the screen is displayed by the system without any user action.

· TimedRefresh – the screen is refreshed every few seconds or minutes.

· RequiresSignOn. A boolean. The screen must run in a security context.

6.69 ScreenAction, Subtype of NamedObj

This object defines what happens when the screen action is activated. The additional attributes are:

· Ops. A list of Operation objects (Cascade = Child). The operation.

· SelectFromTable. A reference to a DataItemTable object. This is for screen actions that are associated with selecting an element from a list or table displayed on the screen. It points at the list or table data item.

· Next. An enumeration. What happens when the screen action is finished. Takes a value from:

· GoToNextScreen – the next action is to display another screen.

· ExitTask – exits from this screen and the entire task.

· Refresh – redisplay the current screen.

· NextScreen. A reference to a Screen object. Defines the next screen if GoToNextScreen is set.

6.70 Script, Subtype of NamedObj

This is the script object. Scripts are associated with Tasks. The additional attributes are:

· Commands. A list of Command objects (Cascade = Child). The script commands. The commands are processed in sequence when the script is run.

· FirstScreen. A reference to a Screen object. The screen that is first displayed before the script is run. The InputOps for the screen are processed.

· ExtraCommands. A list of ExtraCommand objects (Cascade = Child). These supplement the processing of the InputOps.

6.71 SecurityContext, Subtype of NamedObj

Models a security context. The additional attributes are:

· Roles. A set of Role objects. The roles controlled by this security context.

· Portals. A set of Portal objects. The portals that use this security context to log on.

6.72 SelectDataEntity, Subtype of DataEntityOp

Finds a data entity, probably using a data defined by an InputDataItem mapping. There are no additional attributes.

6.73 SelectRowExtra, Subtype of ExtraCommand

Some data mappings come from a table. This tells the script processor what row in the table to use.

· Row. An integer.

6.74 SetValue, Subtype of MapDataItem

Sets an output value from a constant or a value calculated by the program. The additional attributes are:

· Out. A reference to a DataItem object. The output destination.

· OutInstanceId. A string. For choosing between different data entities of the same type.

· Value. A string. The output value or a description of the output value.

6.75 SetForeignKey, Subtype of MapDataItem

Sets an output value by constructing a foreign key from a data entity. The additional attributes are:

· Out.  A reference to a DataItem object. The output destination.

· OutInstanceId. A string. For choosing between different data entities of the same type.

· DataEntity. A reference to a DataEntity object. The data entity from which the foreign key is found.

6.76 Stakeholder, Subtype of NamedObj

These objects are meant to be used for documenting the stakeholders in a new application development. They are not used in any diagrams. It has one additional attribute:
· Requirements. A set of Requirement objects. These are meant to be the requirements set by this stakeholder.
6.77 Stop, Subtype of Operation

Stops the processing of a list of operations. Normally used in conjunction with an If operation. Note it does not imply stopping the task or any going to another screen.

6.78 SubjectArea, Subtype of NamedObj

Subject areas provide a classification of the definitions.

· Definitions. A set of Definition objects (Inverse = SubjectArea).

· SubSubjects. A set of SubjectArea objects (Cascade = Child). The subject area split into subject areas.

· SuperSubjects. A set of SubjectArea objects (Inverse = SubSubjects). The subject area it belongs to.

· RelatedObjects. A set of NamedObj objects. Points at more or less any object in the model that has a name. This is for cross reference purposes.

6.79 TableOp, Subtype of Operation

This is a virtual object definition. It is for operations that use tables. The additional attribute is:

· Table. A reference to a DataItemTable object. The target table for the operation.

6.80 Task, Subtype of PortalTask

This defines tasks. The main attribute is ConsistsOf which describes what the task actually does. The additional attributes are:

· TimeWhenRun. A string. Some text defining when the task is run – like “daytime” or “24 hours”.
· StartEvent. A string. Some text defining what events starts the task – like “when letter arrives”, “when data is available”.
· ConsistsOf. A list of TaskPart objects (Cascade = Child). TaskParts are things like screens.

· TaskData. A reference to a TaskData object (Cascade = Child). This is shared data for the task. This is particularly relevant if the ConsistsOf objects are screens.
· DataSecurityList. A list of DataSecurity objects. Used to restrict what data the task can use.
· InProcessSteps. A set of TaskStep objects. Indicates the next step in a process.
· AbortUndoUpdates. A boolean. If true and the task aborts, then all the data updates done in the task must be undone – the data should revert to its state as it was before the task ran.

· ExtraAbortOps. A list of Operation objects. These are operations that are called if the task is aborted. An example of what you might want to do here is to send a message to a monitoring task.
· OpGroups. A set of OpGroup objects. This is just a place to put OpGroup objects.

· RequirementsSupported. A set of Requirement objects (Inverse = RelatedTasks). See RelatedTasks.
· Application. A reference to an Application object. The IT application that implements this task.

· Scripts. A set of Script objects (Cascade = Child). Used in script diagram.
6.81 TaskData, Subtype of DataHolder

A holder for the data items used for task data. When the task is executed the TaskData data items are created when the task starts and are deleted when task finishes. The additional attribute is:

· Task. A reference to a Task object ( Inverse = TaskData). The task that owns the task data.

6.82 TaskPart, Subtype of NamedObj

This is a virtual definition. TaskPart objects are the processing elements of a task. The additional attribute is:
· Start. A boolean. When the task starts this is the first element to be run.

6.83 TaskStep, Subtype of ProcessStep

 A step that is a task. The additional attribute is:

· Task. A reference to Task (Inverse = InProcessSteps). Points are the task.

6.84 TrayOp, Subtype of Operation

This is a virtual object definition. TrayOps are to do with work pending trays. Work pending trays are essentially queues that are used as a way of communicating between tasks. Each entry in the queue references a data entity instance. There is one additional attribute.

· Tray. A reference to WorkPendingTray object. The target tray.

Note, the tray object defines the type of the data entities in the tray.
6.85 UpdateDataEntity, Subtype of DataEntityOp

Updates a data entity. The details of updated attributes is defined by the DataMapping. There are no additional attributes.
6.86 Verify, Subtype of Operation

Checks the data. If the check fails the operations, there is no undo of any of the data updates. If it is called from a screen the screen is refreshed with an error message. There is one additional attribute.

· CheckCondition. A string. The test – written in plain English.

6.87 VerifyExtra, Subtype of ExtraCommand

This tells a “verify” operation whether to fail or not.

· Fail. A boolean. If true, fail.

6.88 WordOrPhrase

The word, acronym or phrase. It can have spaces.

· Name. A string. The word or phrase.

· Definitions. A set of Definition objects.

6.89 WordRelationshipKind , Subtype of NamedObj

Defines how words can be related to other words. (More precisely how definitions relate to other definitions.)

· FromText. A string. What the relationship is called going from From to To.

· ToText. A string. What the relationship is called going from To to From.

6.90 WorkPendingTray, Subtype of NamedObj

Work pending trays are a way of marking objects in order another task can pick them up later.

· DataEntity. A reference to a DataEntity object. Only data entities of this kind can be added to the tray.
· Ops. A list of TrayOp objects (Inverse = Tray). List of tray changing operations.
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